Chapter 4: SEER*DMS Workflow
The SEER*DMS workflow is a configurable mechanism to move records through automatic and
manual tasks. The workflow controls the path of a record through editing, screening, matching,
and consolidation tasks with the goal of incorporating that record’s data into Patient Set data.
Each record is initially processed in an automated task. If human attention is required to complete
a task, a manual task is initiated. Once a user completes the manual task, the record continues to
the next automatic task in the workflow. The record moves from automatic to manual processes
as necessary, until it completes its journey through the workflow.
The SEER*DMS worklist provides a view of the automatic tasks that are currently running and the
manual tasks that require attention. Manual tasks are created to process patient data, view report
output, and to review import statistics. The manual tasks displayed in the worklist are the staff’s
“to do list”. The automatic tasks are displayed in the worklist to allow you to track the flow of data
and, in rare situations, to cancel automatic processes.
In this chapter, you'll learn about
• Accessing the Worklist
• Worklist Data Columns and Filters
• Sorting the Worklist
• Assigning or Releasing Worklist Tasks
• Worklist Flags
• Auto-setting Worklist Flags
• Report and Extract Worklist Tasks
• Terminating Manual Tasks
• Refresh or Restart Workflow Activity
• Sending Records into the Workflow
• Aborting Automatic Tasks
• System Failure Tasks
• Worklist Tasks
• Workflow Listings and Reports
• Technical Implementation of the Workflow
• Workflow XML
• Understanding the Workflow Diagrams

Accessing the Worklist
There are many ways to access the worklist. The most common method is to click one of the
shortcuts shown on the home page. You can also select View > Worklist or press Alt+W. The
method that you use to access the worklist determines the initial filter settings. Once you are in
the worklist, you will be able to adjust the filters to view an appropriate list of tasks. The system
permissions assigned to your user account determine which tasks you will be able to view and
access.
There are numerous shortcuts to the worklist on the home page. In most registries, users are
instructed to focus on tasks assigned to their account (displayed in the tab labeled Mine on the
left). You may also be instructed to use worklist flags to identify high priority tasks or to work on a
certain task type.
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All links in the Tasks sections on the left and right sides of the home page will take you to the
worklist. The Tasks link that appears above the tabs can be used to view all tasks for that tab. For
example, click Tasks while viewing the Mine tab to view all tasks assigned to your account
regardless of task type.
When you open a worklist task, it is assigned to your account and locked to prevent two users from
inadvertently working on the same task. The lock prevents another user from opening or
modifying a task that is in progress. A task that is in progress cannot be opened, re-assigned, or
modified. The lock is removed when you complete or cancel out of a task.
The steps and account permissions required to assign or release tasks are described in Assigning
and Releasing Tasks.

Worklist Data Columns and Filters
The following data columns are shown in the worklist:
• Flags – Tags to indicate that there is something “special” about the task. Flags are
assigned to tasks to mark priority tasks, problem tasks, and tasks related to certain
projects. A flag can be assigned to a task manually; or automated rules can be defined in
the Task Manager (System > Workflow > Task Manager).
• Task –ID assigned to a task when it is created. The same ID is maintained as a record
moves from one type of task to the next. However, the task ID may change when the
record is linked to a patient set. TSK is the prefix for task IDs.
• Task Type – The types of tasks are described in the Worklist Tasks section of this chapter.
• User - The user account to which the task is assigned.
• Age or Task Date – This column can be used to show either the length of time since the
task was created or the date created. Use Action > Toggle Age/Date to switch between
length of time and date. The task date and age are reset when the data move forward to a
new task type.
• ID – For most tasks, this is the ID of the Patient Set or Record that is the focus of the task.
If the processing of a record triggered the task and the record is not yet linked to a Patient
Set, the Record ID will be shown. Once the record is linked to a Patient Set, the Patient Set
ID will be shown. The ID shown for a Report Output task is the system report ID (RPT
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prefix). The Import ID (IMP prefix) is shown for an Import Review task. Click the
Information Icon
next to the ID to see values of key fields.
• Type – The Type column shows Data Type. A two-character abbreviation is used: NA for
NAACCR Abstract records, NM for NAACCR Modified records, DC for Death Certificate
records, etc. The abbreviations for the data types are listed in the Data Type filter; or hover
your mouse over the abbreviation to view the full text.
• Reg – Region. This column is only displayed if your registry’s implementation of SEER*DMS
is configured to support multiple regions. Region is assigned to a record or Patient Set by
registry-specific polishers. It is typically based on the region of the facility that sent the
data.
• Event Date – This is typically date of diagnosis. If a record is the focus of the task then
the record’s Event Date is used. The record’s Event Date is calculated by a polisher and is
the date of diagnosis, if available. Otherwise, it is set to the value of another date field on
the record such as screening date, date of admission, or date of last contact (refer to the
documentation for the Date of Event Polisher on the Polishers help page).
• Facility – Reporting facility.
• Site – Cancer site.
• Information – A text field displaying additional task-specific data items (Patient Name,
match results, IDs of failing edits for edit-related tasks, etc.).
Values Displayed for Data Type, Region, Event Date, Facility, Reportability, and Site
Data Type, Region, Event Date, Facility, Reportability, and Site are set to values from a single
record or a single CTC in the patient set.
These are the rules for selecting the record or CTC that provides the values of these fields:
• Consolidate task – Use values from a pending record.
o

If one of the CTCs requires visual editing then select a pending record linked to that
CTC. If two CTCs require visual editing then the values are obtained from the
pending record of the CTC with the latest Dx Year.

o

If none of the CTCs with pending records requires visual editing then select from all
pending records. An abstract will be selected, if available. If there are multiple
abstract records then select one using this priority: Health Record, NAACCR
Abstract, NAACCR Modified. If there are multiple pending abstracts, then the record
with the latest event date is used. If there are no pending abstracts then a registryspecific priority is used to pick a pending record.

• Resolve Patient Set Errors task – Use values from a linked record or a CTC.
o

If one of the CTCs requires visual editing then the values are obtained from that
CTC’s source record. If two CTCs require visual editing then the values are obtained
from the source record of the CTC with the latest Dx Year.

o

If no CTCs require visual editing, then CTC values are used and the CTC with the
latest date of diagnosis is selected.

• Other Patient Set tasks – the latest diagnosed CTC that has edit errors is used. If no CTC
level edits are failing then the CTC with the latest date of diagnosis is used.
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You may filter the worklist by any fields shown in the data columns. The fields listed below are
available as filters, but not shown in worklist data columns.
• Status – Use this filter to find a task based on its execution status. All manual tasks have
a status of Waiting. Automated tasks will either have a status of running or failed.
• In Progress – Use this to filter based on whether a person is actively working on a task. A
task is in progress if it was opened by the user to whom it is assigned and that user is
currently working on the task. A lock is shown next to the user name when a task is in
progress.
• Last Name – This filter provides a method to search for a task by the patient’s last name
or for patients whose names start with specific letters. In some registries, sets of letters
are assigned to coders. For example, a coder in one registry completes tasks for patients
whose names start with any of these letters: H L F Y. The letters must be separated with a
space to use the filter to find patients whose name starts with any of those letters.
• Reportability – Use the Reportability filter to search for record tasks by the record’s
reportability flag.
• Import – Use this filter to search for record tasks based on the Import ID. It will also
return Patient Set tasks if one of the linked records was loaded in the import; and that
record is pending or is the source record of a CTC that requires visual editing.
• Open AFL – This filter was designed to facilitate searches for records that triggered an AFL,
the AFL is still open, and the record is in a manual worklist task. It can also be used to find
Patient Sets that are in the worklist and have an open AFL.
• AFL Closing Record – Use this filter to find records that closed an AFL. Typically, this
would be an abstract that matched an AFL for a pathology report, death certificate, or case
finding record. Other types of records, such as Short Health Records, may also close AFLs.
• Special Study – Use this filter to find tasks for records or Patient Sets in Special Studies.
• Data Search Filter – This filter allows you to create custom filters based on any criteria
related to a record, Patient Set, task, or facility. To do this, create a Data Search that
returns the display ID for a Patient Set, Record, Facility, or Task. Save that Data Search as
a filter for the Worklist Manager.
The fields listed below are available as worklist filters in some, but not all, registry configurations.
• Class Of Case – The value in this filter is matched against the class of case in records
associated with tasks; or the class of case in admissions for Patient Set tasks.
• Vendor – This filter can only be used to search for record tasks. The value entered in this
filter is matched against the Vendor Name field in the records.
• Abstracted By – In some registries, the abstractor’s Contact ID with a PER prefix is listed
in the worklist information field. If a Contact ID is not available, the 3-character abstractor
ID is listed. To facilitate faster searching, the Abstracted By filter executes a match against
the text in the information field rather than matching against record values.
Instructions for setting filters are provided in the Filter Tutorial available with the SEER*DMS user’s
manual: seer.cancer.gov\seerdms\manual.

Sorting the Worklist
In SEER*DMS, the data displayed in a table are sorted by the column with the highlighted header
(Task is highlighted in green below). In the example below, the worklist is sorted by Task ID. The
up arrow next to “Task” indicates that the table is sorted in ascending order.
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You may sort by a different column if that column header is underlined. You cannot sort the
worklist by the data in the ID column; but you can sort by all other data items. To sort the
worklist, click on a column heading. To reverse the sort order, click that column header again. If
you create a saved filter, the sort order will be stored as an attribute of the filter. For more
information on filters, please refer to Chapter 3: Using SEER*DMS.

Assigning or Releasing Worklist Tasks
System permissions: worklist_action_reassign_all, worklist_action_reassign_mine,
worklist_action_take_on_click
Tasks can only be assigned to a user who has the system permission to complete the task. A user
can open tasks assigned to their account; and tasks that are unassigned. When a user opens an
unassigned task, the task is assigned to that user’s account.
Worklist tasks can be auto-assigned to users. Registry criteria are defined in Groovy scripts which
can be viewed and modified via the SEER*DMS Task Manager (go to System > Workflow > Task
Manager). The Assignment tab of the Task Manager contains scripts to auto-assign tasks to
system users. The IMS Technical Support team will provide assistance in creating and maintaining
the scripts. A sample script is shown whenever you add a script.
• The Help section of the editor shows a list of Functions that can be used and allows you to
search for data items (Properties).
• Typically, the scripts are written so that they do not re-assign a task that is already
assigned to a user. If task.getUser() is not null then the script should return
Result.currentUser() and the task will not be changed.
Users with the worklist_action_take_on_click permission can take another user’s task simply by
clicking the TSK-ID in the worklist.
To manually assign or release an open worklist task:
1. If you wish to set a worklist flag before you release the task or assign it to another user:
a.

Select Worklist Flags from the Task menu (the Task menu is displayed on the menu
bar next to View).

b. Check the flags that are appropriate for this task.
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2. To assign the task to another user, select Reassign from the Task menu.
a. Set the Action to Assign to User Account(s), and select one or more user names from
the list. The list will only include users who have the system permissions required to
open the task.
b. Enter text into the Comment box. This text will be included in the e-mail notification
sent to the user(s) receiving the task.
3. To designate the task as unassigned, select Task > Release.
4. If you have the system_administration permission, Terminate and Restart will be included
on the TSK menu. Restart is only available for record-based tasks. Terminate and Restart
should be used with care (see the Terminating Manual Tasks and Restarting Workflow
Activity sections of this chapter for more information).
To use the Worklist to assign or release worklist tasks:
1. Select View > Worklist or use a shortcut on the Home Page to go to the worklist.
2. Set the appropriate worklist filters. Instructions for using the filters are provided in the
Filter Tutorial on the SEER*DMS training website: seer.cancer.gov\seerdms\manual.
3. Select the tasks to modify:
a. Use the filters to limit the worklist to the tasks that you wish to modify.
b. Or check the boxes in the first column to select specific tasks. If items are checked,
actions are applied to the checked items. If no items are checked, actions are applied to
all items in the filtered list. To select all tasks on the current page, check the box in the
header row. To select specific tasks, check individual boxes to the left of the Task ID.
Check boxes can only be checked on a single page--the checks will clear if you go to
another page in the worklist.
4. Select Actions > Modify.
5. To assign the selected tasks to one or more users:
a. Set the Action to Assign to User Account(s)
b. If you would like to select users based on a system role, select that role in the dropdown list.
c. Check one or more user names in the list. The list will only include users who have the
system permissions required to open all of the selected tasks. If multiple users are
selected, the tasks will be divided among those users.
6. To change the task(s) to unassigned, set the Action to Release to Unassigned List.
7. Enter text into the Comment box. This text will be included in the e-mail notification
related to this action. SEER*DMS sends an e-mail notification to a user each time a task or
set of tasks are assigned to their account.
8. Click OK. A warning will be displayed if more than 100 tasks are modified.

Worklist Flags
A worklist flag is a tag associated with a task to indicate that there is something “special” about the
task. Flags provide a way to prioritize tasks. For example, a worklist flag can be set to indicate
that a task is related to a record that is likely to generate a new reportable case. Registry
management can create worklist flags; registry staff can set flags for a task. The flags listed below
are distributed with SEER*DMS.
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Flag

Description

Explanation

Probable New
Patient Set

The automatic match task did not find a patient set that is a definite
match. It is likely that this record will become a new patient set.

New CTC

The automated match identified a Patient Set that is a match, but the
record did not match a CTC within that patient set. The record may
represent a new incident case for the patient.
The SEER multiple primary rules or registry-specific algorithms may
be used to match a record to CTCs.

Problem Case

This flag is typically assigned to a task by a user. However, the
registry may define a script to auto-assign the flag.

CFO

The task is for a record being built into a Casefinding Only case.

DCO

The task is for a record being built into a Death Certificate Only case.

SHO

The task is for a record being built into a Short Health Only case.

MDO

The task is for a record being built into a DCO case using the defaults
for data received from physician offices (MDO).

To define or modify worklist flags (requires manage_worklist_flags permission):
1. Select System > Worklist Flags.
2. To create a new flag, select Actions > Add. To modify the icon or name of a flag, click
Edit for that flag.
3. In the Flag field:
a. Specify one or two characters for the flag’s icon.
b. Click Color and select the background color for the flag’s icon.
4. Enter the flag’s Name. The Name is shown when a user hovers over the icon and in the
list of flags displayed when a user sets flags for a task.
5. Enter a Description to document the purpose of the flag. Click Save.
A priority is assigned to each flag. It is a sequence from 1 to the number of flags. The priority
determines the order in which flagged tasks are listed on the user’s home page. Tasks with priority
equal to 1 are listed first. To change the priority of a flag: select Actions > Set Priority. You
may drag the flags up and down within the list to change the priority.

Auto-Setting Worklist Flags
The registry may define scripts to automatically set flags on worklist tasks. Scripts are distributed
in the initial deployment of SEER*DMS to set the P and C flags. The CF, DC, SH, and MD flags are
set by source code in the application rather than the Task Manager scripts.
Registry criteria to set flags can be defined in the scripts. The scripts can be accessed via the
SEER*DMS Task Manager (go to System > Workflow > Task Manager). The Flags tab contains
scripts to automatically set flags on tasks.
The IMS Technical Support team will provide assistance in creating and maintaining the Flag
scripts. A sample script is shown whenever you add a script.
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Report and Extract Worklist Tasks
An automatic task is started when a user runs a system report or extract. When the automatic
task finishes successfully, a manual Report Output task is created and assigned to the user who
submitted the report or extract. Instructions and options for running reports and extracts are
provided in Chapter 24: Creating Reports and Extracting Data.
Report Output tasks have characteristics that differ from tasks related to records moving through
the workflow. These are described below.
• The report or extract ID is listed in the ID column of the worklist (RPT or EXT prefix).
• Report Output tasks can be removed by the user to whom it is assigned. The Remove
Report Output action allows you to remove a single task or a set of tasks.
• Report Output tasks expire after a period of time. The length of time is set in configuration
parameters (report.removal.time and extract.removal.time). The default is 90 days for
extracts and 30 days for reports. Email notification is sent when reports expire. To keep a
permanent copy of a report or extract, you must download it to your computer or network.
• You can assign a Report Output task to any user, but they will only be able to open it if they
have the permission associated with the report. For example, a report designated for
managers only can be opened by a user with the reports_management permission.
To remove Report Output tasks assigned to your account (the report or extract will be deleted from
the system):
1. To remove a single report or extract, open the task and click Remove.
2. To remove a set of reports or extracts, select the Report Output tasks in the worklist using
one of these methods:
a. Use the filters to create a list containing the reports to be removed.
b. Or check the box next to each Task ID.
3. Click Modify.
4. Set the Action to Remove Report Output.
5. Click OK.

Terminating Manual Tasks
System permissions: worklist_task_terminate_manual
You may use the terminate feature to end manual worklist tasks. The terminate feature should be
used with extreme care when dealing with tasks related to records or Patient Sets moving through
the workflow. The task is ended without forwarding the record or Patient Set to subsequent
processes in the workflow.
You may terminate a single task by opening the task and selecting Terminate from the Task’s
menu. You may also terminate one or more tasks using the Modify action in the worklist.
To terminate tasks in the worklist:
1. Use the filters to create a list containing the tasks to be terminated. For example, you may
be terminating all tasks for records loaded in a particular import.
2. Carefully verify that your filter settings are correct before proceeding. Review the worklist
to see if the appropriate tasks are listed.
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3. Click Modify.
4. Set the Action to Terminate.
5. Click OK and confirm the action when prompted. The tasks will be removed from the
workflow. SEER*DMS will send an e-mail notification to you and the system administrator.
An entry will be added to the record’s Worklist History indicating that the task was
terminated.
Instructions for ending automated tasks are provided in the Viewing or Aborting Automatic Tasks
section of this chapter.

Refresh or Restart Workflow Activity
System permission: worklist_task_refresh or worklist_task_restart
At times, registry staff may need to refresh a stale task. Refreshing a task simply re-runs the
automatic portion of the task. For example, the edits are re-executed when a Resolve Patient Set
Errors task is refreshed. Record and Patient Set tasks can both be refreshed.
If a Patient Set is updated by any process, the edits are re-evaluated. If the Patient Set is in a
Resolve Patient Set Errors task and all edits are resolved, the task will auto-close. If changes are
made to the computerized edits, you can re-execute the edits on all Patient Sets using the Patient
Set Edits system tasks. Resolve Patient Set Errors tasks will auto-close if all edits are resolved.
Therefore, you will rarely need to refresh Resolve Patient Set Errors tasks. This would only be used
if you wanted to test a change to an edit on tasks before executing the system task to refresh edits
on all Patient Sets.
In addition, records in tasks can be sent to an earlier point in the workflow. Sending a record to an
earlier point in the workflow is dangerous and should be done with care. Contact IMS technical
support if you need to restart tasks and are not sure of the possible side effects.
To refresh tasks:
1. To refresh a set of tasks, use the filters to create a list of tasks.
2. Select Actions > Modify.
3. Set Action to Refresh Tasks.
4. Click OK and then confirm the action when prompted.
To send records to an earlier point in the workflow: (proceed with care)
1. To restart an open task, select Restart from the Task menu.
2. To restart a set of tasks, use the filters to create a list of the tasks to be restarted.
a. Select Actions > Modify.
b. Set Action to Start Tasks at Earlier Point in Workflow.
c. Review the number and type of tasks. Verify that you wish to proceed.
3. Select the point in which the task will re-enter the workflow. The tasks are listed in the
order in which they occur in the workflow. You cannot push tasks forward in the workflow,
that is, you cannot restart a Screening task at the point of Matching.
a. Auto-coding – the rec-coding polishers will be executed. Review the rec-coding
polishers for the appropriate record type(s) to determine if this is an appropriate action.
The logic for each polisher is documented on the Polishers help page.
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b. Record edits – all record edits will be executed. The results will determine whether a
manual Resolve Record Errors task is created as described in Chapter 8: Resolving
Record Errors. As an example, you may wish to restart tasks at this point after
correcting a poorly defined edit that created a large number of Resolve Record Errors
tasks. If a manual edits task is not created, the record will continue moving through the
workflow.
c. Screening – the algorithm to set the reportability flag will be re-applied. These
algorithms are documented on the Screening help page. You may wish to restart tasks
at this point if the screening algorithm was modified and you wish to apply the new
algorithm to records loaded prior to the change.
d. Matching – the automatic matching task will be refreshed. This will reset the worklist
flags and information text that are set by the automatic match task. If you are
restarting pathology reports that use the Pull List workflow then the records will be sent
to the automatic Path Matching task.
4. If you want to release the tasks, check Set as Unassigned. Do not check this box to
retain the current assignment.
5. AFLs are created for some records as they move through the workflow. The records that
you are sending back into the workflow may have AFLs. You have the option of deleting
the AFLs and creating new AFLs per current algorithms. Do not check this option if you do
not want changes to the AFLs.
6. Click OK and then confirm the action when prompted.

Sending Records Into the Workflow
System permission: send_into_workflow
Records that are not in the workflow can be sent to the workflow via the Data Search. Execute a
record or SQL data search that includes Record IDs in the results, and then select Send Records
Into Workflow from the Actions menu. The records will enter the workflow at the point selected
in the dialog box. If you are unsure of the appropriate entry point or possible ramifications of
sending the records into the workflow, please contact SEER*DMS Technical Support. Please test on
the SEER*DMS test server before sending a large number of records into the production workflow.
Reportability will be reset (set to unknown) for any record sent into Auto-coding, Record Edits, or
Screening. These records will be re-screened and Manual Path Screening or Screening tasks may
be created.
Auto-coding
The auto-coding polishers will be executed. The records will proceed to the Record Edits step of the
workflow (see below).
Record Edits
The records will be validated via record edits. The records will then move to Screening (see below).
Screening
The auto-screener will evaluate the record and attempt to set reportability. A manual Path
Screening or Screening task will be created if the auto-screener cannot determine reportability. The
record will then proceed to duplicate record checking.
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Duplicate Record Check
The incoming record is compared to records of the same type. If a match is found, the matching
record will be updated and the incoming record will be deleted. If the matching record was linked,
then it will be auto-consolidated so that updates are made to Patient Set fields. If a matching
record was not found then the incoming record will proceed to standard matching.
Matching
No changes will be made to the records. Each record will be matched against the database. The
record type, reportability, and workflow routing scripts will determine where the record goes after
the automatic match task. Possible outcomes:
•

Record stops in a manual Match task

•

Record is auto-consolidated into a patient set

•

Record moves to a manual Consolidate task

•

or the record exits the workflow.

In Seattle, a Pathology Report record sent to Matching will go to the Pathology Match task. The
record would then follow the Pull List workflow: Pull List Algorithm, Two Tier Algorithm, Standard
Matching, etc. The record could stop in a Review Path Matching, Review Pull List, or MatchConsolidate task; or it may exit the workflow.

Aborting Automatic Tasks
System permission: worklist_task_terminate_auto
When SEER*DMS performs an automated process, an automatic task will appear in the worklist.
These items allow users to track the progress of automatic tasks through the workflow, and view
additional information about an item, if necessary.
SEER*DMS will run most automated processes quickly, and remove the item from the worklist as
soon as the task is completed. On rare occasions, a system administrator may need to abort an
automated process. If you have the worklist_task_terminate_auto permission and determine that
an automated task needs to be canceled, open the task and click Abort Task.

System Failure Tasks
A System Failure task will be created if SEER*DMS is unable to perform a process. The task type
will be displayed in red and ‘FAILURE’ will be printed in the information text. A user who has the
permission to perform the initial task will be able to open the System Failure task. When you open
the task you will see the type of workflow activity that failed, the time and date that the activity
was started, and the runtime exception generated.
If you cannot evaluate the information, contact your registry IT staff or submit a SEER*DMS
technical support issue. Technical support team will determine if a Retry would be appropriate.
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Worklist Tasks
The manual workflow tasks are listed below.
Manual Tasks
Consolidate
Image Data Entry
Import Review

Match

Match Review

Pathology Screening

QC Patient Set
QC Record
Report Output
Resolve Duplicate Patient
Set
Resolve Patient Set Errors
Resolve Record Errors
Review Data

Review Path Matching
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Description
Combine data from incoming records with data previously loaded
into the system (Chapter 12: Consolidating Data).
Enter record data stored in an image file.
Review a pre-load analysis of an import in order to identify
potential errors prior to loading the records into the workflow
(Chapter 5: Importing Data Files).
Review possible matches for an incoming record. Determine
whether the record should be consolidated with an existing
Patient Set, or if it refers to a new Patient Set (Chapter 10:
Matching Incoming Records to Database).
This task provides a second review to prevent duplicate patient
sets from being created. In this task, the user reviews Patient
Sets that may match the incoming record. These Patient Sets
were identified as possible duplicates when SEER*DMS
attempted to build a Patient Set from the incoming record. If the
patient set is a duplicate, then the original match task may have
been completed by a user who made a mistake and did not see a
matching Patient Set; or the original match task may have been
auto-completed and the linkage algorithms did not identify the
Patient Set as a match.
Code site, histology, behavior, grade, and the reportability flag
on records containing pathology reports. This task is typically
used to screen HL7 records; it may also be used to screen
casefinding records in some registries.
Manual Quality Control tasks that can be created by registry
staff. QC Tasks can be created in the Data Search. Use the
search to select the records or Patient Sets and then select
Create QC Task from the Action menu.
Access the output of a report (Chapter 24: Creating Reports and
Extracting Data).
This task identifies a Patient Set that was recently modified and
may be a duplicate of another Patient Set. An automatic task is
executed each night to identify possible duplicates.
Resolve errors identified in the final automated review of the
Patient Set (Chapter 14: Resolving Patient Set Errors).
Resolve errors which must be resolved prior to screening
(Chapter 8: Resolving Record Errors).
Review Data is a Patient Set task that can be created during ad
hoc editing sessions. To create the task, you select Create
Review Task from the Patient Set menu and enter instructions.
Review possible matches generated by the automatic path
matching task. A pathology report is matched against Patient
Sets and reject records as part of the Pull List workflow.
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Manual Tasks
Review Pull List

Review Special Studies
Screening

Description
Determine if a pathology report should be included in the “Pull
List”. If the record is included then an AFL is created and the
medical records will be “pulled” for a chart review.
A task created when a manual review is required to determine
special study eligibility. (Chapter 28: Special Studies)
Screen an incoming record for reportability (Chapter 9:
Screening for Reportability).

Workflow Listings and Reports
To create a printout or listing of tasks in the worklist, select Export from the Actions menu. This
creates an export file in Comma Separated Values (CSV) format. Open the file in Excel to format
and print the list.
These SEER*DMS system reports can be used to monitor data and tasks in the workflow.
Report ID
RPT-003A
RPT-008B

Title
Tasks for Unlinked Records
with Closed AFLs
FUP Abstract Workflow
Summary

RPT-008C

DC Duplicate Workflow
Summary

RPT-008D

Record Duplicate Workflow
Summary
Workflow Location of
Imported Records

RPT-061A

RPT-062A
RPT-075A

Workflow Tasks by Facility
and Year of Diagnosis
Number of Open Worklist
Tasks by Data Type

RPT-075B

Number of Open Worklist
Tasks by User

RPT-082A

Number of Workflow Tasks
Completed (by Task)

RPT-082B

Number of Workflow Tasks
Completed (by User)

RPT-082C

Number of Workflow Tasks
Completed (by Data Type)

SEER*DMS Workflow

Description
Lists workflow tasks for unlinked records which are
associated with closed AFLs.
Outcome of records processed in the FUP Abstract
workflow in SEER*DMS v13-v16. Use RPT-008D for
records processed in v17 and later.
Outcome of records processed in the DC Duplicate
workflow in SEER*DMS v13-v16. Use RPT-008D for
records processed in v17 and later.
A summary of results for records processed by the
workflow as duplicates.
For each record imported at a specified time, this
report lists the current location of the record in the
workflow. It is paged by the import data file which
contained the original record.
A list of tasks in the workflow by facility and year
of diagnosis.
Number of open, manual workflow tasks by year of
diagnosis and data type (Patient Sets and the
various types of records).
Number of open, manual workflow tasks by user
account (total, number of unassigned tasks, and
number assigned to each user).
The number of workflow tasks completed in a
specified time period. This report includes a list of
users for each type of task.
The number of workflow tasks completed by each
user in a specified time period. This report lists
the number of tasks per user.
The number of workflow tasks completed for each
data type in a specified time period.
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Report ID
RPT-096A
RPT-096B

RPT-100A

Title
Priority Worklist Tasks
(Probable New Patients)
Priority Tasks -- Probable
New Cases for Existing
Patient Sets
Abstracts in Workflow that
Match Patient Set with an
Open AFL

Description
A listing of records in the workflow that do not
match any Patient Set on SSN.
A listing of records in the workflow with the same
SSN as a Patient Set in the database.
A list of abstracts that are in the workflow, match
a Patient Set based on SSN, and that Patient Set
has an open AFL. This report only considers AFLs
that have a Patient Set as the source.

Understanding the Workflow Diagrams
Workflow diagrams are available at the end of this chapter. These are generic diagrams, that is,
they indicate points which use registry-specific logic but the registry algorithms are not
documented in the diagrams. To truly understand the workflow for a specific record, you will need
to review the appropriate diagram and your registry’s algorithms. Registry algorithms are
documented in the SEER*DMS help system and workflow routing scripts. The text below describes
the processes and decision points shown on the diagrams.
Process
Create Record (via
Import or Data Entry)

Auto-coding

Record Edits

Special Studies Screen

4-14
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Description
The import processes include identifying and ignoring duplicate
records; loading data into record fields; and applying import
conversion rules. The import algorithms are described in Chapter 5
and registry-specific documentation is available on the Imports help
page in SEER*DMS.
Note: A temporary record is created for supplemental records; the
record is only stored in the database if a manual task is required.
Automatic task that executes polishers in the rec-coding and reccoding-type groups. Refer to the Polishers help page for more
information; you may filter by group.
Validate the record using edits. Create a manual Resolve Record
Edits task if edits fail and at least one of the edits has a severity level
of critical or high. The registry has the ability to create manual tasks
to review record edits at two points in the workflow.
• Edit task may be executed just before the record is screened;
the edit task is used at this point to identify records that are
missing critical data items.
• Edits may also be executed just after the screening task; this
allows the registry to restrict validation to records that are
known to be reportable.
Refer to the Edits Manager, Edits Help Page, or Chapter 7 of this
manual for more information related to edits, edit conditions, and
relevant documentation.
Automatic task that applies user-defined criteria to determine the
eligibility of incoming records for special studies. This task can be
executed before and/or after the Screen for Reportability task.

SEER*DMS User Manual

Process
Screen for Reportability

Description
Apply screening algorithms and set the reportability flag on the
record. The algorithms are documented on the Screening help page.
The reportability flag indicates whether the record contains data
related to a reportable cancer. It indicates whether the record is
reportable to the registry. The value of the reportability flag is “not
applicable” for supplemental records (non-medical records that
provide follow-back information).

Record Screening (post)

This script runs after automatic screening. If reportability could not
be set by the auto-screener then a manual task is created,
otherwise, the record moves to the next automated task in the
workflow.
Pathology reports are sent to Path Screening tasks so that the user
can view the text and code disease information. Abstract and other
pre-coded records are sent to the Standard Screening task so that
the user can resolve coding issues that prevented the screener from
determining reportability.

Create AFL

Typically, the script’s result is determined by the auto-screener logic
as documented on the Screening help page.
An Abstract Facility Lead (AFL) is the SEER*DMS implementation of a
case finding lead. Case finding sources vary by registry and may
include pathology reports, disease index data, registry-specific case
finding records, and reportable death certificates.

Match to AFLs

Create AFL is an automated task. An AFL will be created and
associated with the incoming record, per registry rules. These rules
are documented on the AFL help page (see Auto-create Rules).
If the record is a reportable abstract, it is matched against open AFLs
using the criteria documented in the Matching: AFL to Record section
of the matching help page. The AFL is closed if the record and AFL
match. In some registries, Short Health records are considered
abbreviated abstracts and are also used to close AFLs.
The auto-close rules are documented on the AFL help page.

Record Duplicate
Evaluation (pre) Routing
Script

SEER*DMS Workflow

This script determines whether a record is sent to Evaluate Record
Duplicate. This is typically used for abstracts and death certificates,
but can be used for other record types. If used, the record is
matched against other records of the same type to determine if it
provides new CTC-level information. If it does not provide new
CTC-level information then it will be processed as a duplicate;
patient-level data on the record is consolidated and the record
deleted.
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Process
Evaluate Record Duplicate

Process Duplicate Record

Match Patient Level (pre)
Routing Script
PLA Workflow

Auto Matching Task

Match Patient Level
(post) Routing Script
Manual Match
Link Record to Patient Set
Or
Auto-build Patient Set
with Duplicate Patient Set
Check

Match Review

Link Record to Patient Set
(post) Routing Script

Description
Compares the record to another record of the same type. This is a
one or two step process, depending on the record type. The first
step uses a matching algorithm is used to identify matching records.
If a more extensive comparison is needed then a list of fields are
compared; the more extensive comparison is only performed on the
records identified by the initial match.
The matching criteria to identify candidates are documented on the
Matching help page (see Duplicate Record Task sections). The more
extensive check is currently only done for abstracts; this is
documented on the Auto-cons help page.
If the incoming record is an updated version of a record in the
database, auto-consolidate the two records. The original record is
updated and retained; the incoming record is deleted. If the original
record was linked, then the Patient Set is automatically updated.
This script is used to decide if a given record should go through the
Pull List Algorithm (PLA) or proceed to standard matching.
The Pull List Algorithm (PLA) workflow was designed by Seattle for
Pathology Reports. Currently, it is only used by the Seattle registry.
This workflow can be used if the registry’s operations include the
import of “reject” records – records that indicate that a case finding
request has been “rejected”.
Match the record against data in the database. This is a
demographic level match task. The goal is to determine whether the
incoming record has data for a new patient; or if there are other data
in the database for this patient.
This script runs after automatic and manual matching. It determines
if a manual task is needed to review the auto-match results.
A Manual Match task is created when the registry rules indicate that
a person must review the auto-match results.
Automatic task that either:
• links the record to an existing matching Patient Set
• Auto-builds a new patient set from the auto-build rules and
checks for duplicate patient sets
If a duplicate patient set is found during auto-build, then the record
is sent for a Match Review and is sent back to the Match Patient
Level (Post) Routing Script.
A manual task created to prevent duplicate patient sets due to
human or algorithmic errors. This task is created if the previous
task attempts an autobuild – and the duplicate check indicates that
the new patient set may be a duplicate.
The record loops back to the Match Patient Level (post) script after
this manual task; it will then go back to the Link Record task.
This script executes after the task that links the record to an existing
patient set or auto-builds a patient set and links the record to the
new patient set.
This script determines if the automated task to auto-consolidate
patient-level fields is called.
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Process
Auto Consolidate (Patient
Level)
Consolidate Patient Level
(post) Routing Script
CTC Matching

Match CTC Level (post)
Routing Script
Link to CTC
Link Record to CTC (post)
Routing Script

Consolidate to CTC
Consolidate CTC Level
(post) Routing Script
Link AFL Source to
Patient Set

Patient Set Edits

Evaluate AFLs & FB

Description
Automated task to apply patient-level auto-consolidation rules (see
Auto-cons help page).
Determines if a manual Consolidate task is created. A task is
typically created if an auto-cons rule failed due to a data
discrepancy.
Automated task to match the record against CTCs. The algorithm
used varies by registry and record type. Typically, the SEER
Multiple Primary rules are used for abstract records and may be used
for pathology reports; the NAACCR Death Clearance rules are used
for death certificates.
This script runs after automatic CTC matching. It determines if the
record should be linked to the CTC found in the previous task.
Automated task to link the record to an existing CTC.
This script executes after the task to link the record to a CTC.
It determines if the automated task to auto-consolidate CTC level
fields is called.
Automated task to apply CTC-level auto-consolidation rules (see
Auto-cons help page).
Determines if a manual Consolidate task is created. A task is
typically created if an auto-cons rule failed due to a data
discrepancy.
If the record closed an AFL, link that AFL’s source record.
Example: an abstract is linked to a CTC. In a previous step of the
workflow, the abstract had closed an AFL for a path report. The Link
AFL Source task links that path report to the same CTC as the
abstract.
Validate the Patient Set using edits with Data Type equal to Patient
Set, NAACCR Line, and any data type that is a sub-entity of the
Patient Set (CTC, Treatment Procedure, etc).
An edit is executed if it is active and the Patient Set meets criteria
specified in the edit’s conditions.
First, apply the AFL Auto-close Rules – Patient Set is Saved. These
rules are documented on the AFL help page.
Second, apply any registry-specific rules to auto-create AFLs or
Follow-back Needs. These rules are documented on registry-specific
workflow diagrams.

Technical Implementation of the Workflow
The SEER*DMS workflow is highly configurable. The route of a record through the workflow is
determined by registry rules based on record type, facility, and values of specific data items on the
record. The workflow diagrams show the workflow processes (tasks) and transitions. The
workflow implementation uses the system components listed below.
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• Workflow Engine. The workflow engine is written in Java. The workflow engine parses
the workflow XML file, executes routing scripts, creates each task, and initiates the
appropriate processes.
• Workflow XML. Task attributes and routing rules are defined in the registry’s
workflow.xml file. The contents of the XML file are described in more detail below.
• Routing Scripts. Each routing script returns a disposition that determines the next
workflow task for the record. The logic in the script uses results of the automated task and
properties of records and patient sets involved in the tasks.
• Edits and Task-Specific Algorithms. Each automated task uses task-specific logic to
evaluate or modify data. Edits and edit conditions are used by the automated edits tasks.
Task-specific algorithms are in place for other automated tasks, including imports,
screening, matching, auto-build, and auto-consolidation.

Workflow XML
The workflow XML defines the attributes of manual tasks, automated tasks, places, and transition
points. The attributes defined in the Workflow XML include those listed below. This is not a
complete list, these are included here to provide a basic understanding of the workflow
implementation and to illustrate the way in which IMS may customize a registry’s workflow via
changes to the Workflow XML.
• activity id – This is a label or variable name used by the Workflow Engine and throughout
the Workflow XML. These are used behind the scenes and not displayed to the user
(import-review, image-data-entry, etc.)
• comment – A script that sets and formats variables displayed in the Information column of
the worklist.
• contained-entity-type – The type of object that is the focus of the task. This object may
be an import (SourceSubmission object), record, Patient Set, AFL, report, etc.
• cleaner: java class (including full package) that must be executed when an activity of this
type is terminated
• name – The formatted title of a task. These are the task names that are shown to the user
(Import Review, Image Data Entry, etc.)
• no-restart – A Boolean that is set to True when a task cannot be sent to an earlier step in
the workflow. This is set to True for tasks that stand-alone and are not part of a full
workflow; these include Review Data, QC Record, QC Patient Set, Review Special Studies,
and Report Output.
• no-retry – A Boolean that is set to True if the workflow does not permit a failed instance of
the task to be re-tried. For example, a failed automatic import task cannot be re-tried. The
cause of the failure would be investigated, corrected, and the files reloaded. A new task
would be created; and the failed task would be terminated.
• ownership – Task ownership affects user assignment. If ownership is set to previousowner then next manual task will be assigned to the same user as this task. If the value is
unassigned then the task will be set to unassigned after it is completed. The task is then
evaluated by workflow assignment scripts to see if the assignment should be changed.
• permission – The system permission required by a person to open the task.
• refresh-entry-point – Some tasks can be refreshed, the automatic portion of the current
task is re-executed. The refresh-entry-point defines the point in the workflow that
corresponds to the automatic portion of the task.
• type – The type is “human” for all manual tasks; the type is java for automated tasks.
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Routing Scripts
Workflow routing scripts allow modifications to a registry’s workflow without requiring a release of
the SEER*DMS application. The proper maintenance of routing scripts requires an extensive
understanding of the SEER*DMS workflow and the impact of changes to registry operations.
Therefore, the routing scripts are only modified by IMS support staff in consultation with a registry
operation manager. Routing scripts can be viewed in the Task Manager (go to System > Workflow
> Task Manager and go to the Routing tab).
Each script must be written in Groovy and must return a string. The string is the name of a
workflow disposition which the workflow engine will use to route the entity (record, patient set,
etc). The routing scripts can use record or patient set properties and the results of automated
tasks, as well as a variety of utility methods. The valid dispositions and utility methods vary by
task type; these are documented on the Help tab in the Routing Rule Editor. The dispositions are
also shown on the workflow diagrams. For example, on Figure A-1 you will see “review-screeningresults” and “review-path-screening-results”.

Edits and Task-Specific Algorithms
Edits and edit conditions determine if a manual task is created to resolve record or Patient Set
edits. The Edits Manager provides a mechanism for writing edits, activating edits of various
standard-setters, and setting conditions that determine the cases on which edits are applied.
Task-specific algorithms are in place for other automated tasks, including imports, screening,
matching criteria, auto-build, and auto-consolidation. These include criteria for creating manual
tasks. For example, the screening algorithm includes logic that determines when a manual
screening task is created. Registry algorithms are documented in the SEER*DMS help system. At
this time, changes to imports, screening, auto-build, and auto-consolidation rules require a release
of SEER*DMS.
Workflow Branches
There are two distinct branches of the workflow: the supplemental workflow and the main
workflow. The supplemental workflow is used for data that provide vital status, date of last
contact, non-cancer cause of death information, and updates to other demographic data items.
The main workflow is used for records that may provide cancer data.
All current SEER*DMS registries use the supplemental workflow if the record’s subtype is
supplemental (SSA, NDI, DMV, etc); or if the subtype is death certificate but there are no
reportable causes of death on the death certificate. A few registries also use the supplemental
workflow for other record types such as death notice and follow-up only. The main workflow is
used for records that may provide cancer data: abstract records, pathology reports, case finding
records, and death certificate records with reportable causes of death.
The supplemental workflow is implemented via import routines that are external to the main
workflow. Typically, data processed in the supplemental workflow are not persisted in the record
table unless a manual task is required to review automatic match results or resolve autoconsolidation conflicts. If SEER*DMS is able to match and consolidate the data without a manual
task, the Patient Set is updated and the Import ID, filename, and line number are recorded in the
Patient Set’s audit log. The record is not saved. However, SEER*DMS supports options that
control the storage of data in the supplemental workflow. For example, all SEER*DMS registries
use the supplemental workflow for non-reportable death certificate records and most registries use
the option to store all death certificate records in the database.
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Workflow Part 1: Record Input, Record Edits, Screening & AFLs

Record Input

Create record
(via Import or
Data Entry)

Autocoding

Record
Edits

Edits Fail

Resolve Record
Errors

No edits

Registry-defined
criteria

Special Studies
Screen

Review Special
Studies

Record Edits, Screening & AFLs

Screen for
Reportability

review-screening-results

Coded recs

review-path-screening-results

Record Screening (Post)

Standard
Screening
(abstracts)

process-record

Special Studies
Screen

Record
Edits

Registry-defined
criteria

Path Screening

Text path reports:
Requires review/coding

Review Special
Studies

Edits Fail

Resolve Record
Errors

Create AFL

Match to AFLs
(Close AFLs)

Key
Manual Task

Proceed to Evaluate
Record Duplicate

Automatic Task

Routing script

Workflow Part 2: Evaluate Duplicate Record & Matching
Continued from [Create/Close AFLs]

Evaluate Duplicate Record

Record Duplicate Evaluation (pre)
evaluateduplicate
proceed-tomatching

Evaluate Record
Duplicate

Duplicate

Not a
duplicate
Dup record deleted

Process Duplicate
Record

proceed-to-pla

Path reports

PLA Worklow

Auto-consolidate to
original record and
Pat Set

Match Patient Level (Pre)

proceed-to-matching

Matching

Auto Matching:
Record to Patient
Level

Manual
Match

review-matchresults

Match Patient Level (Post)

exit
create-afl-then-exit
delete-record

link-to-pat-set
Match
Review
New Pat Set fails
dup check

Link Record to
Patient Set/Autobuild new Pat Set/
Duplicate Pat Set
Check

Key
Manual Task

Automatic Task

Proceed to Linkage/Consolidation
Routing script

Workflow Part 3: Linkage & Consolidation
Continued from Matching
Key

Fail dup check
See flowchart 2

process-pat-set (rare)

Link Record to
Patient Set/Autobuild new Pat Set/
Duplicate Pat Set
Check

Link Record to Patient Set (Post)

Manual Task

Automatic Task

Routing Script

manual-consolidate

consolidate-topat-level
Auto Consolidate
(Patient Level)

Linkage & Consolidation

process-pat-set

Consolidate Patient Level (Post)

manual-consolidate

match-to-ctc

CTC Matching

process-pat-set

Match CTC Level (Post)

manual-consolidate

Manual
Consolidate

link-to-ctc

Link to CTC

process-pat-set

Link Record to CTC (Post)

manual-consolidate

consolidate-to-ctc
process-pat-set
Consolidate to
CTC
Continue with
Link AFL source
to Patient Set

Continue with
Link AFL source
to Patient Set
Consolidate CTC Level (Post)

manual-consolidate

Workflow Part 4: AFL Source, Patient Set Edits and Follow-back

AFL Source, Patient Set Edits & Follow-back

Continued from Linkage/Consolidation

Link AFL source to
Patient Set

Patient Set Edits

Edits fail

Resolve Patient
Set Errors

Evaluate AFLs and
Follow-Back

Key
Manual Process
End: Exit Workflow

Automatic Process

